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Aha!
Configuration Aha!
Log into your Aha! admin session, on Settings choose Account and go to the Security and
single sign-on tab
Choose SAML 2.0 as your identity provider and fill the following fields:
Name
Trustelem

Metadata URL
https://mydomain.trustelem.com/app/33XXXX/metadata

Logout redirect URL
https://mydomain.trustelem.com/app/33XXXX/on_logout

Trustelem Configuration
On Trustelem, write your Aha! custom domain in the corresponding field
You can verify this value in the URLs displayed on Aha! SAML page :
https://accountname.aha.io ... )

Airbrake
Airbrake Configuration
Log into your Airbrake admin session, go to Account & Billing and go to the Security tab
Click on Enable SAML and fill the following field:
SAML/IdP Metadata URL
https://mydomain.trustelem.com/app/33XXXX/metadata

Trustelem Configuration
On Trustelem, write your Airbrake subdomain name in the corresponding field

Apimo
Activate SSO for APIMO
Send an email to support@apiwork.com with the following contents (adapt it to your
actual requirements):
Please enable Trustelem for my Apimo subscription (https://mydomain.apimo.pro/homepage).

My base Trustelem URL for Apimo is https://mydomain.trustelem.com/app/93XXX

Modification should be applied on [put your desired date here] at [hour].

Await support confirmation.

Setup Trustelem groups
Apimo requires the users' agency and profile.
Use the following procedure so as to make Trustelem transmit these attributes:
Create a group for each one of your agencies in your directory
Synchronize these groups with Trustelem and rename them "Organization/Agency_name"
using the "groups" tab in your admin dashboard
Create a group for each one of your profiles in your directory
Synchronize these groups with Trustelem and rename them "Profile/Profile_name" using
the "groups" tab in your admin dashboard
Notes:
A user can only be in a single Organization group and a single Profile group.
The "Agency_name" and "Profile_name" have to match those in Apimo.
If you can't use directory groups, you can create them in Trustelem instead.

AppDynamics
AppDynamics Configuration
Log into your AppDynamics admin session, go to Administration and then to the
Authentication Providers tab
Select the SAML option and fill the following fields:
Login URL
https://mydomain.trustelem.com/app/33XXXX/sso

Logout URL
https://mydomain.trustelem.com/app/33XXXX/on_logout

Identity Provider Certificate
https://mydomain.trustelem.com/app/33XXXX/metadata

Username Attribute
username

Display Name Attribute
displayname

Email Attribute
email

By default the username will be the user email but you can change that in Custom
scripting ; if you want username to be firstname.lastname for example add these two
lines:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
msg.setAttr("username", user.firstname+"."+user.lastname);
}

You can also define AppDynamics roles according to attributes sent by Trustelem in SAML
Group Mappings
In SAML Group Attribute Name write 'groups'
In Group Attribute Value, check the Multiple Nested Group Values option

In Mapping of Group to Roles add Trustelem groups to which you want to match
AppDynamics roles

Trustelem Configuration
On Trustelem, write your AppDynamics name account in the corresponding field. You can
find your name account on your AppDynamics url which looks like https://[nameaccount].saas.appdynamics.com/

To send your users' Trustelem groups, add these lines in Custom scripting:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
for (let g in groups) {
msg.addAttr("groups", groups[g].name);
};
}

Arcgis
ArcGIS Configuration
Log into your admin session on ArcGIS, then go on Organization, Settings and then
Security
In Login, set up a SAML login with the One Identity Provider option and fill the following
fields:
Name:
Trustelem

Your users will be able to join:
Automatically

A Trustelem authenticated user but unknown by ArcGIS will be created thanks to its SAML
attributs
Download the metadata file and in File put the file you have downloaded
In the advanced settings:
Disable Encrypt assertion, Enable signed request, Propagate logout to Identity
Provider
Enable Update profiles on sign in if you want your ArcGIS users updated with the
received SAML attributes
Put the following Logout URL:
https://mydomain.trustelem.com/app/225XXX/on_logout

Leave the default Entity ID value

Trustelem Configuration
Replace domain-name by your ArcGIS domain name in the EntityID and Assertion
Consumer Service Trustelem fields

AssetSonar
AssetSonar Configuration
Log into your AssetSonar admin session, go to Add Ons and then to the SAML Integration
tab
Click on Enable and fill the following fields:
Identity Provider URL
https://mydomain.trustelem.com/app/33XXXX

Identity Provider Certificate
$cert = "MIIDXXX...XXXNTYw=="

Identity Provider Certificate
https://mydomain.trustelem.com/app/33XXXX/metadata

Login Button Text
Trustelem

Clock Drift (seconds)
0

First Name
firstname

Last Name
lastname

Email
email

By checking Only authenticate members that are already added to your AssetSonar
account you don't allow the creation of AssetSonar accounts when new users login for the
first time

Trustelem Configuration

On Trustelem, write your AssetSonar company name in the corresponding field. Its
value can be found in your AssetSonar url : https://[company-name].assetsonar.com//

Automox
Automox Configuration
Log into your Automox admin session, go to Settings and then go to the Security tab
On the SAML option, click on Enable and fill the following fields:
Entity ID
https://mydomain.trustelem.com/app/33XXXX

x509
$cert = "MIIDXXX...XXXNTYw=="

Login URL
https://mydomain.trustelem.com/app/33XXXX/sso

Logout URL
https://mydomain.trustelem.com/app/33XXXX/on_logout

By checking (Optional) Provision New users you allow the creation of a new Automox
account when a user login through SSO for the first time

Trustelem Configuration
On Automox, copy the link given in Automox ACS URL and paste it in the corresponding
field on Trustelem

AWS
AWS Configuration
Open an root session on https://signin.aws.amazon.com
Click on Services and under the Security, Identity & Compliance tab, click on IAM
Click on Identity Providers and then click on Create a provider
In Provider type choose SAML
Enter the provider name and upload the metadata
Finalize the creation by clicking on Next step and End
Go on the Roles tab and click on Create role
Select SAML 2.0 federation
Choose the SAML provider, check Allow programmatic and AWS Management
Console access
On the forth step, choose the role name and click on create

Trustelem Configuration
Go back on Settings for AWS on Trustelem and copy the AWS account ID in Subscription ID
On the same page write the identity provider name

Role Configuration
The code below allow to assign roles to users. As so, to assign roles you need to edit the
script in the app settings and return the wished roles
function getRoles(user: User, groups: Groups): string[] {
return ["Role1", "Role2"];
}

Information
AWS returns two attributes:
https://aws.amazon.com/SAML/Attributes/Role with value ARN role, ARN Provider

https://aws.amazon.com/SAML/Attributes/RoleSessionName with value user.email

BambooHR
BambooHR Configuration
Log into your BambooHR admin session and in the setting go to the Apps tab
Download the SAML Single Sign-On application, click on Settings and fill the following
parameters:
SSO Login URL
https://mydomain.trustelem.com/app/33XXXX/sso

x.509 Certificate
$cert = "MIIDXXX...XXXNTYw=="

Trustelem Configuration
On Trustelem, fill Organization Name with your BambooHR organization name

Blissbook
Blissbook Configuration
Log into your Blissbook admin session and go to Organization and then to Account
Settings
In Authentication, edit Via Single Sign-On and chose the SAML 2.0 option
Fill the following fields:
Button Text
Trustelem

SSO Endpoint
https://mydomain.trustelem.com/app/33XXXX/sso

Unique Employee Identifier
Email Address

X.509 Certificates
$cert = "MIIDXXX...XXXNTYw=="

Trustelem Configuration
On Trustelem, fill Organization name with your Blissbook company name

BlogIn
BlogIn Configuration
Log into your BlogIn admin session, go to Settings and to the User Authentication tab
Go to the Single Sign-On section and click on Configure SSO & User Provisioning
Enable Single Sign-On and fill the following fields:
Name (Optional)
Trustelem

Metadata URL
https://mydomain.trustelem.com/app/33XXXX/metadata

Trustelem Configuration
On Trustelem, write your BlogIn domain name in the corresponding field.
It can be found in your BlogIn URL https://[domain-name].blogin.co/

Bonusly
Bonusly Configuration
Log into you Bonusly admin session and go to Integrations
Choose SAML, click on edit, check Simply provide your IdP Metadata URL & Issuer, we'll do
the rest and fill the following fields:
IdP Metadata URL
https://mydomain.trustelem.com/app/33XXXX/metadata

IdP Issuer (Entity ID)
https://mydomain.trustelem.com/app/33XXXX

Trustelem Configuration
On Bonusly, copy the value given in App ID and paste it in the corresponding field on
Trustelem

Boond Manager
BoondManager automatically connects users if login on Trustelem and BoondManager are equal.
You can force authentication through Trustelem - preventing users from signing in with their
BoondManager password:
Display the Resources List
Select the target user
Click on Configuration button, on the upper-right corner
Select Security tab
Check option Enable exclusive authentication from a trusted third party
Save

Box
Download your metadata file and send it to support@box.com.
The metadata file can be found in the Trustelem setup page of your application.
Await confirmation from support.

Breezy
Breezy Configuration
Log into your Breezy admin session, go to Recruiting Preferences and then to Integrations
Choose the SAML module in the Single Sign-On Section
Download Trustelem metadata and upload them in the SAML Metadata File section

Trustelem Configuration
On Trustelem, write your Breezy company name on the corresponding field. If in doubt,
this value can be found in the given URL on the SAML SSO Settings page :
https://app.breezy.hr/api/auth/saml/company/[your-company-name]

Bugsnag
Bugsnag Configuraiton
Log into your Bugsnag admin session and go to Organization settings
Click on Single Sign-On and fill the following field:
SAML/IdP Metadata URL
https://mydomain.trustelem.com/app/33XXXX/metadata

You can check Auto-provision collaborators if you wish collaborators to automatically join
your organization when they log in through SSO
You can also check Force your team to log in via your SSO provider to prevent
authentication with login and password, but this option is available only once an
administrator logged in through SSO

Trustelem Configuration
On Trustelem, write the name of your Bugsnag organization in the corresponding field

CakeHR
CakeHR Configuration
Log into your CakeHR admin session and go to Settings, Integrations and then SAML SSO
Fill the following fields:
Entity ID:
cake.hr

Authentication URL
https://mydomain.trustelem.com/app/33XXXX/sso

Key fingerprint (hash)
Download the application certificate and get its fingerprint by opening a
terminal and entering the following command with replacing the file name with
the certificate's one:
openssl x509 -noout -fingerprint -sha256 -inform pem -in file-name.pem

Copy the fingerprint and paste it in CakeHR but erase all the ':' present in the
fingerprint

Trustelem Configuration
On Trustelem, fill Company name with your CakeHR company name

Ci-book
Send an email to support@dserv.de with the following contents (adapt it to your actual
requirements):
Please enable Trustelem for my ci-book subscription (https://sub-domain.ci-book.com).

My Trustelem OAuth URLs for ci-book are:
- https://mydomain.trustelem.com/app/166XXX/auth
- https://mydomain.trustelem.com/app/166XXX/token
- https://mydomain.trustelem.com/app/166XXX/resource

Users should be forced to sign-in through Trustelem from [put the appropriate date here].
In the meantime, please keep the standard login form together with Trustelem sign-in
process.

Await support confirmation.

CoderPad
Configuration CoderPad
Log into your CoderPad admin session and in your organization, go to Team Settings
In the Single Sign-On (SSO), click on configure SSO settings
Download the metadata and import them in Automatic import
You can also customize your CoderPad subdomain and then use this link to log in using
SSO

ConnectWise Control
ConnectWise Configuration
Log into your admin session on ControlWise Control
Go on the Administration panel, then go in Security and Enable SAML
Click on Configure and fill the following fields:
IdentityProviderMetadataUrl
https://mydomain.trustelem.com/app/33XXXX/metadata

UserNameAttributeKey
NameID

UserDisplayNameAttributeKey
displayname

EmailAttributeKey
email

RoleNamesAttributeKey
role

DisplayName
The value written here will complete the Connect with displayed on the
ConnectWise authentication page

Trustelem Configuration
Click on Save Configuration and then on Generate Metadata
In the metadata, on the first line, copy the link located in entityID=" "
On Trustelem, cut the link in the EntityID field
Fill the Roles fields with one or several roles separated by commas; these roles with be
applied by default to all users
You can overload the roles with the Advanced setting's script, for example:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
for (const cust_group in groups) {
if (cust_group === "admin") {

msg.addAttr("role", "Control Administrator");
}
}
}

Coralogix
Coralogix Configuration
Log into your Coralogix admin session and go to Settings and to the Configure SAML tab
Activate the SAML, download Trustelem metadata and upload them on Coralogix

Trustelem Configuration
On Trustelem, write your Coralogix team name on the corresponding field

Corporama
Send an email to support@corporama.com with the following information:

ClientID: trustelem.oauth2.gmyXXX

ClientSecret: zokzH[...]DRY

https://mydomain.dev.tlm.io/app/12XXX/auth

https://mydomain.dev.tlm.io/app/12XXX/token

https://mydomain.trustelem.com/app/12XXX/resource

Await confirmation from support.
Enter your Corporama account name. It is used to generate the URLs:
Redirect_URI → https://corporama.com/oauth2/nom_de_compte
Login → https://corporama.com/login/sso/nom_de_compte
If you have a doubt, you can ask your account name to Corporama in the previous
email.

Datadog
Datadog Configuration
Log into your Datadog admin session and in the bottom left corner, go to Configure SAML
Download Trustelem metadata and import them in Datadog
To allow the automatic creation of new accounts when users log in for the first time you
need to verify a domain name associated to users emails in Just-In-Time Provisioning

Notes
In the Additional features, check Identity Provider Initiated Login
By checking SAML Strict Mode, users will have to log in through SSO

Trustelem Configuration
Copy the Single Sign-on URL given in Datadog and paste into the corresponding field on
Trustelem

Demo OIDC
Demo App configuration
Click on the button below to automatically setup an instance on the Demo App
It uses the following data:
ClientID: trustelem.oidc.gvrwgzdc
ClientSecret: f7O6M0P26EMg5oQVR9h4GZxWW2S01XYD
OIDCProviderMetadataURL: https://mydomain.trustelem.com/app/33XXXX/.wellknown/openid-configuration

Trustelem configuration
Setup the Scopes:
Scopes are the user attributes that will be sent to the application
If the field is left blank, all default Scopes will be allowed
If you want to customize Scopes, enter at least the Scope email
The Demo app displays both current and previous login information to see the
impact of different Scopes

You're done!
You can now login to the application, using the user's dashboard or through the following
URL: https://demo.trustelem.com/gvrXXXXXXXXXXXwgzdc/auth

Digital Recruiters
Configuration
Send an email to support@digitalrecruiters.com with the file Trustelem metadata.
Await confirmation from support.
In Trustelem application, replace {domain} by your Digital Recruiters domain.
In Trustelem application, replace {slug} by your Digital Recruiters company ID.
If you have a doubt, you can ask a confirmation of their values in the previous email.

Note
If you want to add/change users' attribute(s), you have to use Custom scripting.

Dropbox
Open an administrator session on https://www.dropbox.com/team/admin/settings/sso
In section Single sign-on, select Optional or Required
Enter the 2 following parameters:
Sign-in URL:
https://mydomain.trustelem.com/app/19XXX/sso

Sign-out URL:
https://mydomain.trustelem.com/app/19XXX/on_logout

Import Trustelem certificate (available on the setup page of your Trustelem application)
Click on Apply changes

Envoy
Envoy Configuration
Log into your admin session and go to Integrations
Install the SAML application and click on Configure
Then fill the following fields:
Fingerprint
54:F2:E3:07:43:28:B4:DA:C9:C5:0C:4F:1E:11:01:66:80:BB:XXXX
this fingerprint can be found on the application documentation on Trustelem admin.

Identity Provider HTTP SAML URL
https://mydomain.trustelem.com/app/3XXXXX/sso

F5 Big-Ip
Supported Features
The integration currently supports the following features:
SAML
Radius

SAML

Radius

Facebook Workplace
Sign in to your Facebook Workplace subscription with an admin account
Click on Company Dashboard and go to Parameters > Authentication
Select « Allow users to login via : SAML only »
Choose your preferred session duration options
Enter the 3 following parameters:
SAML URL
https://mydomain.trustelem.com/app/3XXXXX/sso

SAML Issuer URI
https://mydomain.trustelem.com/app/3XXXXX

SAML certificate
$cert = "MIIDXXX...XXXNTYw=="

Configure Trustelem by setting the ACS URL and Audience URL parameters, accessible
through the Hide setup instruction bottom-right button of this panel
Click on Test SSO
Once the test is OK, click on Save

Freshdesk
Open an administrator session on https://sub-domain.freshdesk.com/
Click on Admin in the top menu
In section General Settings, click on Security
Turn on Single Sign On (SSO)
Select SAML SSO
Enter the 3 following parameters:
SAML Login URL:
https://mydomain.trustelem.com/app/124XXX/sso

Logout URL:
https://mydomain.trustelem.com/app/124XXX/on_logout

Security Certificate Fingerprint (available in the setup page of your Trustelem
application --> Display setup instructions)
Enter user(s) of your choice in field Send notifications to of section Admin
Notifications
Save

GitHub
GitHub Configuration
Log into GitHub with the session of the owner of the organization, then go into the
organization settings and into Organization Security
Click on Enable SAML authentication and fill the following fields:
Sign on URL
https://mydomain.trustelem.com/app/33XXXX/sso

Issuer
https://mydomain.trustelem.com/app/33XXXX

Public certificate
$cert = "MIIDXXX...XXXNTYw=="

Trustelem Configuration
On Trustelem, fill the Organization Name field with your GitHub organization's name
On GitHub you can click on Test SAML Configuration and then on Save

Information
Single sign-on in GitHub authenticates to a specific organization in GitHub and does not
replace the authentication of GitHub itself. Therefore, if the user's github.com session has
expired, you may be asked to authenticate with GitHub's ID/password during the single
sign-on process
By using SSO, a user could automatically join the GitHub organization even if not invited
previously
To sum up, on GitHub SSO allows to access an organization easily but does not replace
the manual authentication of the user

GlassFrog
GlassFrog Configuration
Log into your GlassFrog admin account and go to Organization Settings and to the SAML
Settings tab
Download the application metadata and import them in Configure using by choosing
Metadata File
You can then choose to manually create GlassFrog accounts or to automatically create
them
You can also force SSO login or let it be optional
Once done, click on Enable

Trustelem Configuration
Copy the given Issuer on GlassFrog and paste it in the Issuer field on Trustelem

Google
Open a session as an administrator on https://admin.google.com
Click on « Security » (may be hidden under « Other commands »)
Click on « Setup Single Sign-On (SSO) »
Check « Setup SSO with third party identity provider »
Enter the 3 following parameters:
Sign-in page URL:
https://mydomain.trustelem.com/app/17XXX/sso

Sign-out page URL:
https://mydomain.trustelem.com/app/17XXX/slo

Change password URL:
https://mydomain.trustelem.com/#security

Download the security certificate from Trustelem and upload it in the Google set up
page
Don't use a domain specific issuer
Don't use a network mask, unless for testing

Harness
Harness Configuration
Log into your Harness admin session, go to Access Management in Security and then click
on Authentication Settings
Click on Add SSO Providers, choose SAML and fill the following fields:
Display Name
Trustelem

Group Attribute Name
email

Download Trustelem metadata and upload them in Upload a new SAML Metadata File

Trustelem Configuration
On Harness, copy the link given at the top of the SAML configuration tab and paste it on
the Assertion Consumer Service URL field on Trustelem

ITBoost
ITBoost Configuration
Log into your admin session on ITBoost
In the settings, go to Advanced Settings and then click on Login Method
In the Enforce login field, select SSO and fill the following fields:
IDP ID
Other

Entity ID
https://mydomain.trustelem.com/app/33XXXX

Certificate
$cert = "MIIDXXX...XXXNTYw=="

Login URL
https://mydomain.trustelem.com/app/33XXXX/sso

Logout URL
https://mydomain.trustelem.com/app/33XXXX/on_logout

Trustelem Configuration
On Trustelem, fill the Domain name field by writing the name of your domain

Join.me
Send an email to domain-verification@LogMeIn.com for initiating a domain verification
request.
Download your metadata file and send it to domain-verification@LogMeIn.com
The metadata file can be found in the Trustelem setup page of your application.
Await confirmation from support.

KnowledgeOwl
KnowledgeOwl Configuration
Log into your KnowledgeOwl admin session and in Settings, click on Security
In the SAML SSO Integration section, click on Enable SSO and fill the following fields:
IdP entityID
https://mydomain.trustelem.com/app/33XXXX

IdP Login URL
https://mydomain.trustelem.com/app/33XXXX/sso

IdP Logout URL
https://mydomain.trustelem.com/app/33XXXX/on_logout

Click on Map SAML Attributes and fill the following fields:
Username / Email
email

First Name
firstname

Last Name
lastname

If needed, you can map other attributes and send them with the advanced settings script
on Trustelem, for example:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
msg.setAttr("username", user.firstname+"."+user.lastname);
}

Download the Trustelem certificate and import it by clicking on Upload IdP Certificate
In Advanced Option, check the second option, Issue a remote logout request using the IdP
logout URL when a reader logs out
You can restrict access to SSO by checking Restrict Access to SSO

Trustelem Configuration

On Trustelem, write your KnowledgeOwn base in the corresponding field

Leapsome
Leapsome Configuration
Log into your Leapsome admin session and go to Admin Settings
Go to the Single Sign On (SSO) tab and click on Enable SAML-based single sign-on
Then fill the following fields:
SSO Login URL (supplied by identity provider)
https://mydomain.trustelem.com/app/33XXXX/sso

Certificate (supplied by identity provider)
$cert = "MIIDXXX...XXXNTYw=="

Trustelem Configuration
Then copy the URL given in Reply URL (receives response from your identity provider) and
paste it in the corresponding field on Trustelem

Lockself
Introduction
Lockself use SAML 2.0 to federate identities.
In SAML terminology, there is a client application which is called Service Provider (SP) and
an identity provider (IdP), here Trustelem.

Application configuration elements, on the SP side
Definition of the pages where SSO authentication is enabled (LoginPath)
Definition of the SAML URL for the SP side: Assertion Consumer Service (ACS)
Definition of the identifier attribute (NameID) and its format
Definition of the IdP (Trustelem) connection URLs
Definition of the certificate(s) used for encryption and/or the signature of SAML content.
Note: these configuration data can be requested in metadata.xml format.

Application configuration elements, on the IdP side
EntityID: application identifier → must be identical to what was indicated on the SP side
Assertion Consumer Service (ACS): URL on the SP side for receiving SAML assertions
generated by the IdP → must be identical to what was indicated on the SP side
NameID Attribute: name of the attribute containing the user's identity in the SAML
response provided by the IdP Trustelem to the SP application → must be identical to what
was indicated on the SP side
NameID Format: format of the NameID attribute. Except in special cases, use the default
value → must be identical to what was indicated on the SP side
Attributes List: additional attributes that can be embedded by the IdP into the SAML
responses, and used by the application on the SP side
RelayState: URL of the page to which the user should be redirected after authentication
Custom login URL: URL used to initialize login via SAML 2.0 in the Trustelem user's
dashboard
Custom scripting: script to add/modify attributes in the SAML responses (example:
attribute from the Active Directory)

Mod Auth Mellon
Configuration
Download the Trustelem metadata file.
Install mod_auth_mellon for Apache Linux (for example apt install libapache2-modauth-mellon for Ubuntu/Debian). This mod may require activation.
Execute the script to create Mellon's data. It will create 3 files: key/certificate/metadata,
required by Mellon.
In the metadata file generated previously (.xml), add after the line
<AssertionConsumerService...>:
<NameIDFormat>urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress</NameIDFormat>

NameIDFormat" has to be adapted if you use a different one in Trustelem and Mellon.
Put the 4 previous files (key/certificate/metadata Mellon + metadata Trustelem) in a folder
accessible for the Web Server (for example /etc/apache2/mellon).
Complete the settings file of you Web Server (in the Apache folder sites-available).
The following example has to be adapted, it was made for a source folder at the root (/)
and with the hostname localhost.
<Location />
Require valid-user
AuthType "Mellon"
MellonEnable "auth"
MellonDefaultLoginPath "/"
MellonEndpointPath "/endpoint"
MellonSPentityId "https&#58;//localhost"
&#35; Files generated by the script:
MellonSPPrivateKeyFile "/etc/apache2/mellon/https_localhost.key"
MellonSPCertFile "/etc/apache2/mellon/https_localhost.cert"
MellonSPMetadataFile "/etc/apache2/mellon/https_localhost.xml"
&#35; Metadata Trustelem:
MellonIdPMetadataFile "/etc/apache2/mellon/metadata-125021.xml"
</Location>

Set up Trustelem with the following parameters:
- EntityID: put the value of MellonSPentityId defined in the configuration above

- AssertionConsumerService: put the combination
https://[hostname]/[MellonEndpointPath]/postResponse

With the previous example, the ACS would be: https://localhost/endpoint/postResponse

Notes
The attributes sent by Trustelem are made available by Mellon under the designation
MELLON_ATTRIBUTE=attribute (they can be found in PHP under $_SERVER).
The name of the attributes can be changed by adding in the location part, the directive:
MellonSetEnvNoPrefix "NAME_ATTRIBUTE" "attribute".

Mod Auth OpenIDC
Configuration
Install mod_auth_openidc for Apache: https://github.com/zmartzone/mod_auth_openidc/
Use apt install libapache2-mod-auth-openidc for a Debian system.
Load the module in Apache via httpd.conf:
LoadModule auth_openidc_module modules/mod_auth_openidc.so

Use a2enmod mod_auth_openidc and restart Apache for Debian
Complete Apache's httpd.conf file.
The following example requires customization according to your context.
<VirtualHost *:443>
# Server setup
ServerName myapplication.tld
# ... your particular directives ...
# OpenID Connect setup
OIDCProviderMetadataURL https://mydomain.trustelem.com/app/146XXX/.well-known/openidconfiguration
OIDCClientID trustelem.oidc.XXXXXXXXX
OIDCClientSecret XXXXXXXX
OIDCRedirectURI https://myapplication.tld/redirect_uri
OIDCCryptoPassphrase XXXXXXXX
OIDCScope "openid"
<Location /sso-login>
AuthType openid-connect
Require valid-user
</Location>
# Specific session cookie durations (seconds)
OIDCSessionInactivityTimeout 300
OIDCSessionMaxDuration 36000
</VirtualHost>

The OIDCCryptoPassphrase parameter is used in particular for encrypting user session cookies.

For logging out users from inside the application, you have to associate a logout URL to an
HTML element like a button or a link. This URL is defined by the redirect_uri with a
logout= parameter and the post-logout URL in a URL-encoded format.
For example, the logout URL could be:
https://myapplication.tld/redirect_uri?logout=https%3A%2F%2Fmyapplication.tld

Setup Trustelem with the following parameters:
- RedirectURI: this URL is defined in the web server configuration (see httpd.conf).
With the previous example, the RedirectURI would be:
https://myapplication.tld/redirect_uri

- Login URL: the application's URL starting the OIDC flow. It is used as a target for the
application on the Trustelem user's dashboard.
With the previous example, the URL would be: https://myapplication.tld/sso-login
- PostLogoutRedirectURI: the URL that indicates where to go after a logout. It is usually
defined in the logout HTML element of your application.
With the previous logout example, the PostLogout URL would be:
https://myapplication.tld

Notes
The attributes sent by Trustelem are provided to the application under the designation
$_SERVER["OIDC_CLAIM_nom"], where the name is defined in the Trustelem-hosted
script in the field called custom claims.
For example, if you add the following custom claim, you will find the user firstname into
the variable $_SERVER["OIDC_CLAIM_attr1"]:*
claims["attr1"] = user.firstname;

If the user authenticated with mod_auth_openidc doesn't exist in the application, we
recommend to create the user using the attributes sent by Trustelem.
This auto-provisioning system enables the implementation of internal rights management
based on attributes sent by Trustelem.
This completes access control policies defined in Trustelem.

Moodle
Moodle uses plugins to manage OpenID Connect authentication.

Download and Install
Download the plugin here.
To install the plugin, follow instructions in the README.md file in the root folder of the
archive.
After installation, ensure the plugin files have the correct permissions :
chown -R www-data:www-data oidc/

Configuration
To configure the plugin, from the Moodle Administration block, go to "Site Administration
> Plugins > Authentication > Manage Authentication"
Click the icon to enable the plugin, then visit the settings page to configure the plugin
Fill the following fields: {{customValue('tokenURL')}}
Provider Name : leave empty or set the name of your choice
Client ID : trustelem.oidc.gvsgcy3e
Client Secret : PMlrIbFW6goMduZkPdaJj8yv99nbT33W{{customValue('tokenURL')}}
Authorization Endpoint : https://mydomain.trustelem.com/app/383693/auth
Token Endpoint https://mydomain.trustelem.com/app/383693/token
Resource https://mydomain.trustelem.com/app/383693/userinfo
Scope : openid profile email
```

* We recommend to activate the following option:

* Force redirect. You can use the "?noredirect=1" URL param if your configuration is not
working

* Setup Trustelem with the following parameters:

* Your Moodle server URL
* Login URL: the application's URL starting the OIDC flow. It is used as a target to the
application on the Trustelem user's

dashboard.

The URL may be : https://yourmoodledomain/

#### Optional configuration

* You can add the following code in the setClaims function of the "custom claims" section of
trustelem application configuration to use user email instead of his identifier as username in
Moodle application.

```ts
claims["sub"] = user.email

Nextcloud
Login as an administrator to your Nexcloud instance at https://nextcloud.domain.com
Enable the "SSO & SAML authentication" app
Go to your SAML settings at https://nextcloud.domain.com/settings/admin/saml

Settings
Attribute to map the UID to:
email

Do not enable option "Only allow authentication if an account is existent on some
other backend. (e.g. LDAP)"

Identity provider Data
Identifier of the IdP entity:
https://mydomain.trustelem.com/app/166XXX

URL Target of the IdP where the SP will send the Authentication Request Message
https://mydomain.trustelem.com/app/166XXX/sso

Optional identity provider settings
URL Location of the IdP where the SP will send the SLO Request
https://mydomain.trustelem.com/app/166XXX/slo

Certificate (available in the setup page of your Trustelem application)

Attribute mapping
Use: displayname and email

Security settings / Signatures and encryption required
Enable the following options:

"Indicates a requirement for the samlp:Response, samlp:LogoutRequest and
samlp:LogoutResponse elements received by this SP to be signed"
"Indicates a requirement for the saml:Assertion elements received by this SP to be
signed"

OAuth 2
Introduction
These settings allow you to connect Trustelem with any OAuth 2.0 compliant implementation.
Before you start the configuration make sure to have access to the OAuth 2.0 settings of the client
application.

Configuration
ClientID
This value is used identify your application. Use it as the clientID setting of your
application.
trustelem.oauth2.gi4dXXXX

ClientSecret
This value authenticate your application on Trustelem, a secure random value is proposed
by default. Use it as the clientSecret setting of your application.
ZeRQXFTVaIJ3qqKuXXXXXXXXXXXXXXX

RedirectURI
List of authorized callback addresses that Trustelem will redirect users to. Enter the
value(s) prescribed by your client application.
Login URL (optional)
This URL is used to provide a direct link to your client application on the Trustelem user
dashboard. Enter here the starting point of the OAuthauthorization flow of your client
application.
Authorize endpoint
This value is a read-only value given by Trustelem. Use it as the authorizationURL in your
application settings.
https://mydomain.trustelem.com/app/62XXX/auth

Token endpoint
This value is a read-only value given by Trustelem. Use it as the grantURL in your
application settings.
https://mydomain.trustelem.com/app/62XXX/token

Resource endpoint
Use this service (GET), with the OAuth access_token as HTTP header and with the required
scope so as to get corresponding values.

https://mydomain.trustelem.com/app/62XXXresource

Authentication header:
Authorization: Bearer < access_token >

Available scopes are:
email
given_name
family_name
organization
phone
groups

Office 365
Introduction
Office 365 does not expose any web interface for setting up Single Sign-On, you must
issue a few Powershell commands.
The following command require a Windows computer with Powershell ≥ 5.0 installed.

Setup Powershell environment
Start Powershell as administrator and enter the following command:
Install-Module MSOnline

Connect to Azure AD
In Powershell, enter the following command and enter your Office 365 administrator
credentials:
connect-msolservice

Change Office federation settings
Issue the following command to load the certificate:
$cert = "MIIDXXX...XXXZWCxicZzKAgV"

The contents of the certificat is available on the setup page of your Trustelem application
Choose a federation brand name for your organization, for instance:
$FederationBrandName = "mydomain.com"

Execute the following commands (adapt the DomainName, the URLs and keep the
backquotes characters ` ):
Set-MsolDomainAuthentication -DomainName mydomain.com -Authentication managed
Set-MsolDomainAuthentication

-DomainName mydomain.com `

-FederationBrandName

$FederationBrandName `

-Authentication

Federated `

-PassiveLogOnUri

https://mydomain.trustelem.com/app/34XXX/sso `

-SigningCertificate

$cert `

-IssuerUri

https://mydomain.trustelem.com/app/34XXX/mydomain.com `

-LogOffUri

https://mydomain.trustelem.com/app/34XXX/slo `

-PreferredAuthenticationProtocol SAMLP

OpenID Connect
Introduction
Trustelem supports authorization code and implicit flows, as well as the OpenID Connect Discovery
1.1 standard.

If your application support the discovery standard
You need to configure the application with the following settings:
ClientID
trustelem.oidc.gi2dXXXX

ClientSecret
kmzHGEKEKFH51r0xXXXXXXXXXXXXX

Issuer
https://mydomain.trustelem.com/app/150XXX

Metadata URL (if required)
https://mydomain.trustelem.com/app/150XXX/.well-known/openid-configuration

If your application does not support the discovery standard
Additional parameters are necessary:
Authorize endpoint
https://mydomain.trustelem.com/app/150XXX/auth

Token endpoint
https://mydomain.trustelem.com/app/150XXX/token

User Info endpoint

https://mydomain.trustelem.com/app/150XXX/userinfo

JWKS
{"keys":[{"kty":"RSA","use":"sig","kid":"150XXX","alg":"RS256","n":"XXX...XXX","e":"AQAB"}]}

Note
RedirectURI: this URL has to be the same as the one defined in the application.
For example, the URL could be: https://myapplication.tld/redirect_uri
Login URL: the application's URL starting the OpenID Connect flow. It is used as a target
to the application on the Trustelem user's dashboard.
For example, the URL could be: https://myapplication.tld/sso-login
For logging out users from inside the application, you have to associate a logout URL to an
HTML element like a button or a link.
This URL is defined by the redirect_uri with a logout= parameter and the post-logout URL
in a URL-encoded format.
For example, the logout URL could be:
https://myapplication.tld/redirect_uri?logout=https%3A%2F%2Fmyapplication.tld

PostLogoutRedirectURI: the URL that indicates where to go after a logout. It is usually
defined in the logout HTML element of your application.
With the previous logout example, the PostLogout URL would be:
https://myapplication.tld

OpenVPN
OpenVPN Community Server

OpenVPN Access Server

OpenVPN Cloud

Opsgenie
Opsgenie Configuration
Log into your Opsgenie admin session and in Settings go to Login and SSO
If you're using Atlassian login siwtch to Opsgenie login
Go to the SAML tab and fill the following fields:
SAML 2.0 Endpoint:
https://mydomain.trustelem.com/app/33XXXX/sso

SLO Endpoint (optional):
https://mydomain.trustelem.com/app/33XXXX/on_logout

X.509 Certificate:
$cert = "MIIDXXX...XXXNTYw=="

You can also check Provision new users on the first login automatically if you want new
users to have their accounts automatically created on Opsgenie at their first login through
SSO

Trustelem Configuration
On Opsgenie copy the link in the Identifier field and paste it in the corresponding field on
Trustelem
On Opsgenie copy the link in the SAML 2.0 Service URL field and paste it in the
corresponding field on Trustelem

OwnCloud
Introduction
OwnCloud use SAML 2.0 to federate identities.
In SAML terminology, there is a client application which is called Service Provider (SP) and
an identity provider (IdP), here Trustelem.
Nota: For more details about OwnCloud setup, contact us

Application configuration elements, on the SP side
Definition of the pages where SSO authentication is enabled (LoginPath)
Definition of the SAML URL for the SP side: Assertion Consumer Service (ACS)
Definition of the identifier attribute (NameID) and its format
Definition of the IdP (Trustelem) connection URLs
Definition of the certificate(s) used for encryption and/or the signature of SAML content.
Note: these configuration data can be requested in metadata.xml format.

Application configuration elements, on the IdP side
EntityID: application identifier → must be identical to what was indicated on the SP side
Assertion Consumer Service (ACS): URL on the SP side for receiving SAML assertions
generated by the IdP → must be identical to what was indicated on the SP side
NameID Attribute: name of the attribute containing the user's identity in the SAML
response provided by the IdP Trustelem to the SP application → must be identical to what
was indicated on the SP side
NameID Format: format of the NameID attribute. Except in special cases, use the default
value → must be identical to what was indicated on the SP side
Attributes List: additional attributes that can be embedded by the IdP into the SAML
responses, and used by the application on the SP side
RelayState: URL of the page to which the user should be redirected after authentication
Custom login URL: URL used to initialize login via SAML 2.0 in the Trustelem user's
dashboard
Custom scripting: script to add/modify attributes in the SAML responses (example:
attribute from the Active Directory)

PagerDuty
PagerDuty Configurationy
Log into your PagerDuty admin session and go to Account Settings and in the Single SignOn tab
Choose the SAML option and fill the following fields:
X.509 Certificate
$cert = “MIIDXXX…XXXNTYw==”

Login URL
https://https://mydomain.trustelem.com/app/33XXXX/sso

Logout URL (optional)
https://https://mydomain.trustelem.com/app/33XXXX/on_logout

By checking Allow username/password login you allow users to log in with their username
and password and don't force them to log in through SSO
By checking Auto-provision users on first login you allow users who do not have an
account in PagerDuty to be created and to join your organization at their first login
through SSO

Trustelem Configuration
On Trustelem, write your PagerDuty organization name in the corresponding field
You can also modify the custom scripting and add a role attribute in the script Four
different roles can be send as attributes: admin (Global Admin), limited_user (Responder),
user (Manager) and read_only_user (Stakeholder) If a user logs in through SSO for the first
time, his role will be this attribute. If there's no attribute his role will be 'user'
https://https://mydomain.trustelem.com/app/33XXXX/on_logout

ParkMyCloud
ParkMyCloud Configuration
Log into your ParkMyCloud admin session and go to the Single Sign-On tab
Click on Enabled
Download the app metadata, in the IdP configuration setting choose Upload an IdP
metadata file and upload the file

Trustelem Configuration
On Trustelem, fill Organization name with your ParkMyCloud organization name

Pingboard
Pingboard Configuration
Log into your Pingboard admin session and in the Admin tab click on Sync & Import
In the Ongoing Data Sync section, click on Custom SSO and go to the Settings tab
Open Trustelem metadata, copy and paste its content in the IdP Metadata section
Then fill the following fields:
Sign in with
Trustelem

Name ID Format
urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress

Trustelem Configuration
On Trustelem, write your Pingboard base-url on the corresponding field. You can find it in
your Pingboard url: https://[base-url].pingboard.com/

Pipedrive
Log into your admin session on Pipedrive
On the top right corner, go to Company settings and then to Single sign-on
In the SAML configuration for Pipedrive section, enter the following parameters:
Issuer:
https://mydomain.trustelem.com/app/33XXXX

Single Sign On (URL):
https://mydomain.trustelem.com/app/33XXXX/sso

X.509 certificate:
$cert = "MIIDXXX...XXXNTYw=="

Once you're done, click on Save and test
If the SSO connection fails and all the fields were correctly completed, change the URL
from https://domain-name.pipedrive.com/settings/sso?success=0 to https://domainname.pipedrive.com/settings/sso?success=1

Click on Enable SSO/SAML for users

Trustelem Configuration
Still on Pipedrive, in the SAML configuration for your Identity Provider (IDP) section, copy
the Single Sign On (SSO) url
On Trustelem, cut the link in the Single Sign On URL field

Proxyclick
Proxyclick Configuration
Log into your Proxyclick admin session and in Settings go to Integrations
Browse the Marketplace and in the Single Sign On tab choose the Generic SAML
application
Issuer
https://mydomain.trustelem.com/app/33XXXX

SAML 2.0 Endpoint URL
https://mydomain.trustelem.com/app/33XXXX/sso

SAML certificate
$cert = "MIIDXXX...XXXNTYw=="

Trustelem Configuration
Copy the link given on Proxyclick in SAML Consumer URL and paste it on the
corresponding field on Trustelem
Copy the link given on Proxyclick in SAML SSO Redirect URL and paste it on the
corresponding field on Trustelem

Pulse Secure
Pulse Secure Configuration SAML

Pulse Secure Configuration Radius

Pydio
Pydio requires a plugin to enable OpenID Connect authentication.

Download and installation
Download the plugin here.
Unpack the archive and move authfront.openid to the plugin directory of your Pydio server
(typically: /usr/share/pydio plugins).
Ensure the plugin files have the correct permissions :
chown -R www-data:www-data authfront.openid/

Open your Pydio admin dashboard, find the plugin under Authentication and enable it

Configuration
Configure the plugin with the following values:
OpenID Issuer
https://mydomain.trustelem.com/app/3XXXXX

OpenID Jwks
{"keys":[{"kty":"RSA","use":"sig","kid":"58930","alg":"RS256","n":"03DSSaM_B0G70aclJFwQK6HRl9hkFg2W5HKCGuAHm5wt2tP4FcQ8RMtLZ_WsdeFlUe9VdUGfACCSExq32k4XDR0PA5FJ9sE2pfGXIyyUP2drhqDI1
Q754faHPjvkX5niiQkaNFby4HBjvsH6VWVU5PfHoHEeT20qemANWNlrfw8-jkMlN1aioWAuWI9LOtGqUHEbZy_zj3GrZrAN7G73rClAtcgsIfeqkg3y5g2p4qRynS_MMmpuYiGz89Hcrr3lS52tKjHATskkII-eA_78SB413KVKxRYSK9DjlA-Wm5Ott4AN99d6sVUIj0jp-fWSIueE4zy4OKrrQR91IYQ","e":"AQAB"}]}

OpenID Configuration
{"issuer":"https://wallixjflacher.trustelem.com/app/384294","authorization_endpoint":"https://wallixjflacher.trustelem.com/app/384294/auth","token_endpoint":"https://wallixjflacher.trustelem.com/app/384294/token","userinfo_endpoint":"https://wallixjflacher.trustelem.com/app/384294/userinfo","jwks_uri":"https://wallixjflacher.trustelem.com/app/384294/jwks","end_session_endpoint":"https://wallixjflacher.trustelem.com/app/384294/end_session","scopes_supported":["email","family_name","give

n_name","groups","name","openid","organization","phone","profile","uid"],"response_types_suppo
rted":["code","code id_token","id_token","id_token
token"],"grant_types_supported":["authorization_code","implicit"],"subject_types_supported":["
public"],"display_values_supported":["page"],"claims_supported":["sub","iss","auth_time","acr"
,"name","given_name","family_name","profile","email","locale","phone_number"],"ui_locales_supp
orted":["fr-FR","enGB"],"id_token_signing_alg_values_supported":["RS256"],"token_endpoint_auth_methods_supported"
:["client_secret_basic","client_secret_post"]}

OpenID ClientID
pydio_client_id

Rollbar
Rollbar Configuration
Log into your Rollbar admin session, go to Settings and then to Identity Provider
In SAML Identity Provider choose Other
Open Trustelem metadata, copy and paste its content in the SAML Metadata field

Trustelem Configuration
On Trustelem, write your Rollbar account name in the corresponding field (you can find it
in Settings > General > Account Details)

Salesforce
Introduction
You have to configure both Salesforce and Trustelem so as to align single sign-on
parameters.

Access to Salesforce parameters
Login as administrator to https://login.salesforce.com
In section « Administer », click on « Security Controls »
Click on « Configure single-sign on for your organization »

Trustelem Configuration
Select a certificate for this application
Choose to enable or disable automatic user provisioning
In the Salesforce administration console, find the parameter named « Salesforce Login
URL » (starting with https://login.salesforce.com/?saml=<...> ), and paste its value in the
corresponding Trustelem field
Get the ProfileID corresponding the to profile that will be given to users created by
automatic provisioning: open the profile details in the Salesforce console, the ProfileID is
in the URL
Paste this value in the field named « User creation ProfileID » in Trustelem
Nota: Salesforce also allows to use directly the Profile name instead of its ID

Salesforce Configuration
On Salesforce single sign-on parameters panel, click on button « Edit »
In section « Federated Single Sign-On Using SAML »:
Check option « SAML Enabled »
Check option « User Provisioning Enabled »
For parameter « SAML Version », select « 2.0 »
For parameter « Issuer », input:
https://mydomain.trustelem.com/app/17XXX

Download the certificate from Trustelem (.pem file) and select it as parameter «
Identity Provider Certificate »
For parameter « Identity Provider Login URL », input:

https://mydomain.trustelem.com/app/17XXX/sso

For parameter « Identity Provider Logout URL », input:
https://mydomain.trustelem.com/app/17XXX/slo

Let parameter « Custom Error URL » empty
For parameter « SAML Identity Type », choose « Assertion contains the
Federation ID from the User object »
For parameter « SAML Identity Location », choose « Identity is in the
NameIdentifier element of the Subject statement »
For parameter « Entity ID », choose « https//saml.salesforce.com »
For parameter « Service Provider Initiated Request Binding », choose « HTTP
Redirect »
Click on button « Save »

SAML 2
Introduction
The SAML 2.0 configuration varies from application to application.
This page provides information about the most commonly used settings on both the application
and Trustelem.
In SAML terminology, there is a client application which is called Service Provider (SP) and an
identity provider (IdP), here Trustelem.

If you are the application developer
Note: our recommendation is to use OpenID Connect rather than SAML 2.0. OpenID Connect is
more modern and more simple than SAML 2.0. If you still want to use SAML, you have 3 options:
Deploy a SAML module in the framework underlying the application (e.g. Wordpress,
Drupal, Symphony). This option does not require any development in the application itself.
Deploy a SAML module in the application's frontal web server (Apache, Nginx).
Use a SAML 2.0 library that will authenticate the user.

Application configuration elements, on the SP side
Definition of the pages where SSO authentication is enabled (LoginPath)
Definition of the SAML URL for the SP side: Assertion Consumer Service (ACS)
Definition of the identifier attribute (NameID) and its format
Definition of the IdP (Trustelem) connection URLs
Definition of the certificate(s) used for encryption and/or the signature of SAML content.
Note: these configuration data can be requested in metadata.xml format.

Application configuration elements, on the IdP side
EntityID: application identifier → must be identical to what was indicated on the SP side
Assertion Consumer Service (ACS): URL on the SP side for receiving SAML assertions
generated by the IdP → must be identical to what was indicated on the SP side
NameID Attribute: name of the attribute containing the user's identity in the SAML
response provided by the IdP Trustelem to the SP application → must be identical to what
was indicated on the SP side
NameID Format: format of the NameID attribute. Except in special cases, use the default
value → must be identical to what was indicated on the SP side
Attributes List: additional attributes that can be embedded by the IdP into the SAML
responses, and used by the application on the SP side
RelayState: URL of the page to which the user should be redirected after authentication

Custom login URL: URL used to initialize login via SAML 2.0 in the Trustelem user's
dashboard
Custom scripting: script to add/modify attributes in the SAML responses (example:
attribute from the Active Directory)

Slack
Trustelem Configuration
Enter the value of your slack sub-domain in the corresponding field on Trustelem.
For example for mydomain.slack.com, enter mydomain

Slack Configuration
Log in your Slack workspace
Click on the drop-down menu then Parameters and administration -> Workspace
parameters
Click on the Authentication tab and setup SAML Authentication.
Paste the following URL in the SAML 2.0 Endpoint (HTTP) field.
https://mydomain.trustelem.com/app/33XXXX/sso

Paste the following URL in the Identity Provider Issuer field.
https://mydomain.trustelem.com/app/33XXXX

Paste the certificate into the Public Certificate field
$cert = "MIIDXXX...XXXNTYw=="

In Advanced Options click on expand
Disable Sign
In the field AuthnContextClassRef change to Don't send this value
In the field Service Provider Issuer let the default url https://slack.com
Enable Responses Signed and Assertions Signed
Click on Save Configuration

SmartRecruiters
SmartRecruiters Configuration
Log into your SmartRecruiters admin session and in the Settings go to Web SSO
Enable Web SSO, edit the configuration and choose an algorithm and a certificate in the
SmartRecruiters Configuration section, it doesn't matter which ones
Then fill the following parameters:
Identity Provider URL
https://mydomain.trustelem.com/app/33XXXX

Identity Provider certificate
$cert = "MIIDXXX...XXXNTYw=="

NameID Format
urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress

Trustelem Configuration
On Trustelem, fill SmartRecruiters company identifier with the corresponding value
Notes:
There isn't additional configuration for the mobile application
For a direct authentication, use the link: https://www.smartrecruiters.com/websso/saml/[CompanyIdentifier]/login

The users manually created in SmartRecruiters can't authenticate with SSO because
they don't have a SSO identifier, but you can add one with the API
For a SSO Identifier update for existing users, all users can be changed at once by
asking the SmartRecruiters support team*

Add/edit a user with a SSO Identifier using API
Create an API key on this page or copy the existing one
Then on this page paste the API key on X-SmartToken
To create a new user:
In POST/users click on Try it out and paste this model adapted for your user:
{
"email": "user-email-address",

"firstName": "user-firstname",
"lastName": "user-lastname",
"systemRole": {
"id": "role-id",
"name": "role-name"
},
"ssoIdentifier": "user-email-address"
}

Execute en copy the replied user id
In PUT/users/{id}/activation, click on Try it out, paste the user id and execute
To update an existing user:
In GET/users click on Try it out, execute and copy the id of the wanted user
In PATCH/users/{id} click on Try it out, paste the user id and then the following
model adapted for your user:
[ { "op":"add", "path":"/ssoIdentifier", "value":"user-email-address" }]

Snowflake
Snowflake Configuration
Log into your Sysadmin or Accountadmin account on Snowflake
Go on Worksheets, create a new worksheet and copy this in it:
use role accountadmin;
alter account set sso_login_page = TRUE;
alter account set saml_identity_provider =
'{
"certificate": "MIIDUTCCAjmgAwIBAgIXXX",
"issuer": "https://mydomain.trustelem.com/app/33XXXX",
"ssoUrl": "https://mydomain.trustelem.com/app/33XXXX/sso",
"type"

: "custom",

"label" : "Trustelem"
}';

Then click on Run

Trustelem Configuration
Copy your Snowflake account URL: it should look like this
https://[account_name].snowflakecomputing.com/ or this
https://[account_name].[region_id].snowflakecomputing.com/

On Trustelem, paste this URL in the EntityID, do not forget the "/" at the end

SolarWinds Cloud
SolarWinds Configuration
Log into your SolarWinds admin session and go to Settings > Organization Settings >
Security
Activate SAML and fill the following fields:
Issuer
https://mydomain.trustelem.com/app/3XXXXX

SAML URL
https://mydomain.trustelem.com/app/33XXXX/sso

Single Logout URL
https://mydomain.trustelem.com/app/3XXXXX/on_logout

Certificate
$cert = "MIIDXXX...XXXNTYw=="

Then go to the Role Mapping tab and write the attributes names you wish for each role
(optional)

Trustelem Configuration
Go back to the Configuration tab, copy the ACS URL given value and paste it in the
corresponding field on Trustelem
You can then add roles to send to SolarWinds in Custom scripting
For example, we want users to have the member role for SolarWinds except John Doe who
will be administrator.
On SolarWinds, in Role Mapping > Organization Roles we write the value 'adminSW' for
Admin and 'memberSW' for Member.
On Trustelem we add this custom script:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
msg.addAttr("groups", "memberSW");
if (user.email == "john.doe@trustelem.com") {
msg.addAttr("groups","adminSW");
}
}

Sprout Social
Sprout Social Configuration
Download the app metadata, send them to the Sprout Social support and ask them to
configure SSO with a custom IdP on your account

StatusHub
Login as administrator to https://statushub.com/
Paste the content of the metadata Trustelem on Status sites / Edit / Restricted Access
The metadata file is available on the setup page of your Trustelem application
Copy/Paste the StatusHub SAML login URL into the field StatusHub URL in the setup
page of your Trustelem application

Tableau
Tableau Configuration
Log into your admin session on Tableau Online
Go to Settings, then on Authentication and in Authentication types, check SAML to active
SSO
Click on Edit Connection
In the 4th step, import Trustelem metadata file
In the 5th step, under Display Name, replace FirstName and LastName by firstname and
lastname and then click on Apply

Trustelem Configuration
Go back on the 1st step and copy Tableau Online entity ID and Assertion Consumer
Service URL to cut them on Trustelem in the corresponding fields

ThousandEyes
ThousandEyes Configuration
Log into your ThousandEyes admin session and in Account Settings click on Organization
Settings
In Setup Single Sign-On click on Enable Single Sign-On and choose the Metadata File for
the configuration
Download the metadata and import the file
Click on override next to Logout Page URL and write the following URL:
https://mydomain.trustelem.com/app/3XXXXX/on_logout

You can then click on Run Single Sign-On Test and Save

TYPO3
TYPO3 allows you to install extensions.
In order to use the SSO, you have to install an OpenID Connect or SAML2.0 extension.
For more details contact our support and indicate which extension you want to use:
support@trustelem.com

UseResponse
UseResponse Configuration
Log into your admin session on UseResponse
Go on Applications in the bottom left corner, scroll until you find Single Sign-On and click
on Enable
Then click on Settings and select the SAML method
You can now complete the following parameters:
idP Entity ID or Issuer:
https://mydomain.trustelem.com/app/3XXXXX

External Login URL:
https://mydomain.trustelem.com/app/3XXXXX/sso

External Logout URL:
https://mydomain.trustelem.com/app/3XXXXX/on_logout

Identity Provider Certificate:
Download the certificate here, select Certificate instead of Fingerprint and put the
certificate
Attribute to be used as Email:
email

Attribute to be used as First Name:
firstname

Attribute to be used as Last Name:
lastname

Attribute to be used as Team Name:
organization

Trustelem Configuration
You have to complete three fields on Trustelem (EntityID, Assertion Consumer Server URL
et Single Logout Service URL) with the information available on UseResponse's page

where you've just set the settings
Once all the fields completed, you can click on Submit on UseResponse

Velpic
Velpic Configuration
Log into your Velpic admin session, go to Admin and then to the Integration tab
Choose the Plugins option, select Add Plugin and choose SAML 2.0
Then fill the following fields:
Enter a service name
Trustelem

Issuer URL
https://mydomain.trustelem.com/app/3XXXXX

Download Trustelem metadata and import them in Provider Metadata Config

Notes
Warning: the identifier used for Velpic SSO authentication is Trustelem email, it has to
match a user's username on Velpic to authenticate successfully
By checking Auto create new users, Trustelem users will be created on Velpic at their first
connection

Trustelem Configuration
Copy the link given in the Single sign on URL on Velpic and paste it in the corresponding
field on Trustelem

WALLIX Access Manager
SAML - Access Manager configuration
Go to your Access Manager admin page
Click on: Configuration → SAML Identity Providers → +Add
Select your organization
Write Trustelem for the identity provider's Name
In the tab Service Provider:
In the field WALLIX-AM Entity ID, enter the value WALLIX-AM
Turn OFF Sign Messages, Encrypt Messages
Turn ON Signed Response, Signed Assertion
In the tab Identity Provider:
Import the Trustelem metadata file
Copy the Redirect Binding Uri and paste it in Redirect Logout Uri replacing «
sso » by « on_logout »
In the tab Domain:
In the field Domain Name, enter the domain for federated users
WALLIX Access Manager builds the user's identifier with the combination: login ID +
@ + domain
Click on the pen, and enter the following attributes:
Login → uid
Display Name Attribute → displayname
Email Attribute → email
Language Attribute → lang
Choose a Default Profile for new users

SAML - Trustelem configuration
Enter the root URL of your Access Manager (ex: https://wam.com/wabam )
Enter your organization identifier (you can find it in: Access Manager → Configuration →
Organizations)
Enter the domain defined in Access Manager, tab Domain of your SAML Identity Provider

SAML - Notes
The date/time on machine running Access Manager has to be exact, or SAML will not work.
WALLIX Access Manager auto-provisions unknown users.
In WALLIX Access Manager, you can activate the DEBUG mode and download the logs:
Settings → Application Settings → Logs
If the users authenticate using email on the Bastion, you need a custom script on the
Trustelem app:
msg.setAttr("uid",user.email);

If you need a different AM profile :
on the Access Manager, in the SAML setup in the Domain tab:
in "Default Profile" section: select "No Default Profile" ,

in the "Attributes" section: click on on the edit button (pen), set the "Profile
Attribute" to "profile"
on Trustelem, in the app settings, add a custom script :
//Define a default profile attribute which matchs the NAME of the Access Manager profile
msg.setAttr("profile","User")
//Change it depending on the email address
if(user.email=="rose.keler@trustelem.demo"){msg.setAttr("profile","Auditor")}
//Change it depending on the groups
for (let group in groups) {
if(group=="Trustelem group name"){msg.setAttr("profile","Auditor")}
}

Radius - Access Manager and Trustelem configuration
In a specific case, it's better to use Radius instead of SAML.
The users come from an Active Directory --> SAML
The users come from an Active Directory but you use mainly "account mapping" -->
Radius
You have some users on the Bastion/Access Manager who are not created yet --> SAML
You have only a few local users that already exist --> SAML
the users will have to change their password because they will be managed on
Trustelem

You have a lot of existing users and you don't want them to change their password -->
Radius
You can use Radius for all cases but SAML is better so it's not recommended:
SAML doesn't need the use of the LDAP/Radius proxy to work
SAML is easy and fast to setup
SAML is more secured
SAML needs the rights for the users to access the AM and Trustelem, no additional
workflows
SAML is compatible with any kind of 2nd factors
push notifications are not working well using radius
fido keys (USB token) are not compatible with radius
Knowing that, if you need to use radius, the steps are:
Setup Active Directory if needed: Active Directory synchronization
Setup the LDAP/Radius proxy: LDAP-Radius
Add an Access Manager application on Trustelem
Add a Radius Server on Access Manager: Configuration/RADIUS Servers
Name: whatever you want
Host: the IP/fqdn of the machine running the proxy LDAP/Radius
Protocol: PAP
Authentication Port: can be find on the Services tab in Trustelem admin page
Connection Timeout: 30 to 60s recommended
Shared Secret: can be find on the Services tab in Trustelem admin page, clicking
on the eye icon
NAS Identifier: empty
Edit the Access Manager domain used for the authentication and in Associated
Authenticators, on Login type select Email address or Simple login (depending of
the login attribute on the Bastion, and the option "Strip Domain" on the Access Manager
Bastion setup), and 2 on Factor.
Define the access rules on Trustelem: Access rules
Setup the 2nd factors on Trustelem: Multi factors authentication

WALLIX Bastion
Trustelem Configuration
Before starting, please be sure to have installed TrustelemConnect on your server, and setup this
application in Trustelem admin Services tab.
LDAP-Radius

Bastion configuration
LDAP

Go on Configuration > External authentication
Create a new LDAP authentication
In the field Authentication name choose a name for your LDAP authentication
In The fields Server and Port, write the server IP where TrustelemConnect is running and
the port defined on Trustelem admin tab Services
In the Timeout field add 30.0 seconds
Tick the Active Directory checkbox
Write the LDAP Base DN provides in your Trustelem Bastion model, in the Base DN field
and let sAMAccountName in the Login attribute and User name attribute fields
Note: if Trustelem users don't have a "sAmAccountName" (local users), you can use
"mail" instead. Doing so, they will authenticate on the Bastion using their Trustelem
email adress
In the User field write cn=LDAP Service account provides by Trustelem,LDAP Base DN and
the LDAP Password provides by Trustelem in the Password field
Click on Apply

RADIUS
Go on Configuration > External authentication
Create a new RADIUS authentication
In the field Authentication name choose a name for your RADIUS authentication
In The fields Server and Port, write the server IP where TrustelemConnect is running and
the port defined on Trustelem admin tab Services
In the Timeout field add 30.0 seconds
Type the Radius Secret provides by Trustelem in the Secret field
Under Two-Factor Authentication check Use primary domain name

Click on Apply

Use primary domain name:
if the LDAP users authenticate using a sAMAccountName (which exist on Trustelem)
you don't have to check "Use primary domain name".
if the LDAP users authenticate using a sAMAccountName (which doesn't exist on
Trustelem) BUT the Bastion LDAP domain name matchs the right part of the
Trustelem email adress (for instance wallix.com for user@wallix.com), check "Use
primary domain name".
if the LDAP users authenticate using a mail, you don't have to check "Use primary
domain name"

LDAP AD Domain
Create a new LDAP AD Domain
Add the correct LDAP/AD domain name.
if the LDAP users authenticate using a sAMAccountName (which doesn't exist on
Trustelem), the LDAP/AD domain name has to match the right part of the Trustelem
email adress (for instance wallix.com for user@wallix.com).
Add the Active Directory authentication
Add the Radius authentication
If you need to mapp users from Trustelem LDAP, use :

cn=[trustelem group],ou=groups,dc=o10332,dc=trustelem,dc=com*

Wombat Security
Download your metadata file and send it to support@wombatsecurity.com.
The metadata file can be found in the Trustelem setup page of your application.
Await confirmation from support.

WordPress
Supported Features
The integration currently supports the following features:
SAML
OpenID Connect
JIT (Just In Time) Provisioning

Configuration
Wordpress OIDC

Wordpress SAML

Workplace
Sign in to your Facebook Workplace subscription with an admin account
Click on Company Dashboard and go to Parameters > Authentification
Select « Allow users to login via: SAML only »
Choose your preferred session duration options
Enter the 3 following parameters:
SAML URL
https://mydomain.trustelem.com/app/76XXX/sso

SAML Issuer URI
https://mydomain.trustelem.com/app/76XXX

SAML certificate (available in the set-up page of your Trustelem application)
Configure Trustelem by setting the ACS URL and Audience URL parameters
Click on Test SSO
Once the test is OK, click on Save

Wrike
Download your metadata file and send it to support@team.wrike.com.
The metadata file can be found in the Trustelem setup page of your application.
Await confirmation from support.

XWiki
XWiki Configuration
Note: the following applies to Windows configuration
Log into your XWiki admin account and go to the Administer Wiki section
Go to the Extensions tab and install the OpenID Connect Authenticator extension
Edit the XWiki.cfg file and write the following line :
xwiki.authentication.authclass=org.xwiki.contrib.oidc.auth.OIDCAuthServiceImpl

Edit the XWiki.properties file and write the following lines:
oidc.xwikiprovider=https://mydomain.trustelem.com/app/150XXX
oidc.endpoint.authorization=https://mydomain.trustelem.com/app/150XXX/auth
oidc.endpoint.token=https://mydomain.trustelem.com/app/150XXX/token
oidc.endpoint.userinfo=https://mydomain.trustelem.com/app/150XXX/userinfo
oidc.scope=openid,profile,email
oidc.endpoint.userinfo.method=GET

oidc.user.nameFormater=${oidc.user.email}
oidc.user.subjectFormater=${oidc.user.subject}

oidc.clientid=trustelem.oidc.gvsteodb
oidc.secret=v0x8W4Gx97uycjBs18xeA5f6fkp2wyIY
oidc.endpoint.token.auth_method=client_secret_basic
oidc.skipped=false

Reboot your XWiki server to take modifications into account

Notes
This documentation applies if you have the standard flavor. If you have another flavor, the
graphical user interface may differ
oidc.scope parameter can be adapted to suit your needs
For SSO to work with existing users, the field User on XWiki has to match their Trustelem
email
To disable Single Sign-On, change the oidc.skipped=false line to oidc.skipped=true

Trustelem Configuration
On Trustelem, write your XWiki server URL in the corresponding field

Roles Configuration
If you want to map your Trustelem roles with XWiki's ones you need to edit the
XWiki.properties file and add these lines:
oidc.userinfoclaims=xwiki_groups
oidc.groups.mapping=YourXWikiGroup=YourTrustelemGroup

The second line must be added for each mapping you want to do
On Trustelem, you need to add these lines in the Custom claims script section:
const xwikiGroups: string[]= [];
for(let g in groups) {
xwikiGroups.push(g);
}
claims["xwiki_groups"] = xwikiGroups;

You can also send more attributes to XWiki by adding these lines in the Custom claims
script section (one line per attribute sent):
claims["name1"] = user.getAttr("attribute1");

These attributes can then be used in XWiki, for example if you want to change usernames
to email-attribute1, you'll need to edit xwiki.properties and write:
oidc.user.nameFormatter=${oidc.user.email}-${oidc.user.name1}

You Don't Need a CRM
Connect with an admin account to https://www.nocrm.io
Go to the admin panel and click on Trustelem section
Enter your Trustelem organization name

Zabbix
Log into your Zabbix admin session and in Administration go to Authentication
Go to the SAML tab, check Enable SAML authentication and fill the following fields:
IdP entity ID
https://mydomain.trustelem.com/app/3XXXXX

SSO service URL
https://mydomain.trustelem.com/app/3XXXXX/sso

SLO service URL
https://mydomain.trustelem.com/app/3XXXXX/on_logout

Username attribute
username

SP entity ID
zabbix

Download Trustelem certificate and go to the zabbix.conf.php file and at line
$SSO['IPD_CERT']= '' add the path to the downloaded certificate For example on Ubuntu
the conf file is located at /etc/zabbix/web/zabbix.conf.php and the line should look like
$SSO['IDP_CERT'] = '/home/user/cert.pem';

Trustelem Configuration
On Trustelem add the path to Zabbix UI, it can look like http://[ip-local]/zabbix/
By default the username will be the user email, if you want to change it and put
firstname.lastname for example, you can add these lines in Custom scripting:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void {
msg.setAttr("username", user.firstname+"."+user.lastname);
}

Zendesk
Zendesk Configuration
Log into your admin session on Zendesk and go the administration center (click on the
four squares in the top right corner and then on admin center)
Go the Security tab and then on Single Sign On
Click on configure next to the SAML button
Complete the following parameters:
SAML SSO URL:
https://mydomain.trustelem.com/app/33XXXX/sso

Remote logout URL:
https://mydomain.trustelem.com/app/33XXXX/on_logout

Certificate fingerprint:
Download the certificate [here]
Find the certificate fingerprint by using Microsoft Management Console for example
In Security for Staff members and End users you can chose to activate the external
authentication via SAML by checking Single sign-on and then SAML

Trustelem Configuration
Change the EntityID by replacing domain-name by your Zendesk domain name
Do the same for the Assertion Consumer Service
In Custom scripting, you can change the script to customize the SAML response message.
For example to send a role:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void
{
msg.setAttr("role","admin");
}

Zscaler Cloud
Zscaler Portal Cloud configuration
Go to Authentication Settings:
https://admin.zscloud.net/#administration/auth-settings

In the field Authentication Type select SAML
Click on Configure SAML
In the field Login Name Attribute write: NameID
Note: the default NameID is the user's email.
If you want to use the upn instead, enter the following script line in Trustelem
application Custom scripting field (see below for a complete example):
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void
{
&#32;&#32;msg.setNameID(user.upn);
}

In the field SAML Portal URL write:
https://mydomain.trustelem.com/app/18XXXX/sso

In Public SSL Certificate, upload the certificate of your Trustelem application
Turn OFF both Enable SCIM-Based Provisioning and Sign SAML Request

If you want to turn ON the SAML Auto-Provisioning function
In Zscaler, activate SAML Auto-Provisioning and enter the following attributes:
User Display Name Attribute : displayName
Group Name Attribute : groups
Department Name Attribute : department
In Trustelem application Custom scripting field, write:
function CustomSAMLResponse(msg: SAMLResponse, user: User, groups: Groups, deny: Deny): void
{
msg.setAttr('displayName', user.firstname + ' ' + user.lastname);
msg.addAttr('groups', 'group1');
msg.addAttr('groups', 'group2');

msg.addAttr('groups', 'groupX');
msg.setAttr('department', 'my_department');
}

Note: instead of the constants "groupX" and "my_department", you can use other user's
attributes.
For instance if you want to use Trustelem group attribute:
for (let name

in groups){

msg.addAttr('groups', name);
}

Here is a complete example of custom scripting:

